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QUESTION NO: 1 
 
Your client needs to reclaim space on their server. To reclaim the space, they want to purge the
deleted documents found in the library. Your client expressed concern that some of the documents
may still be referenced by other documents in the library. These documents may need to be
recovered in the future.
 
 
Which action do you need to take to purge only the documents that are no longer being used?
 
 
A. Open the Related Documents pane from the View menu. Scroll through the documents in the
Deleted documents view, purging only those with no links in, as displayed in the lower panel. 
B. Open the Related Documents pane from the View menu. Scroll through the documents in the
Deleted documents view, purging only those with no links to, as displayed in the upper panel. 
C. Open the Brokenlinks panefrom the View Menu. Scroll through the documents in the Deleted
documents view, purging only those with no broken links in. 
D. Open the Lost Document view. Because this shows only the document with no links in, you can
purge all deleted files from view. 
E. Select all files in the deleted Document view and purge them, because those documents that
are linked to by nondeleted documents will be purged. 
 

Answer: A

Explanation: If you attempt to delete a document from the Library that is used by other

documents, 

you have the choice to delete the selection only or the selection and all related documents. 

Clicking the View related documents link displays a list of the related documents. The 

related documents list includes the direct and indirect links for each parent document 

selected. 

 

The Deleted Documents view in the Library displays the 

documents that have been deleted, but not yet purged by the content Administrator. 

 

 

 

QUESTION NO: 2 
 
UPK supported languages are grouped by the Tier Structure, Tier 1 and Tier 2. Which of the
following is not translated if it is a Tier 2 language?
 
 
A. Player Interface 
B. Developer 
C. Default and Microsoft template Text 
D. Static text in Document publishing formats 
 

Answer: B
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Explanation: As per following table: 

Software User Interface,Tier 1,Tier 2 

Setup Translated Not Translated 

Developer Translated Not Translated 

Player Translated Translated 

 
Reference:ORACLE USER PRODUCTIVITY KIT V11.0 –FREQUENTLY ASKED QUESTIONS,:
What languages are supported by UPK?
 
 

 

 

QUESTION NO: 3 
 
What is the first step to set up an unattended installation of the Knowledge Center?
 
 
A. Run the executable silently. 
B. Record the parameter file by using the /r parameter. 
C. Log a support ticket. 
D. Use a third-party program to record the installation options. 
 

Answer: B

Explanation: Unattended Installation 

You can use Push technology to distribute executable files for the setup to user desktops. You 

record response files which contain the pre-determined default settings, and then you can run 

the executable silently. If you deploy executable files in this manner, no interaction is 

necessary on the part of the user. The administrator can control the installation. 

You can record response files for any of the setup executables. 

Record the Parameter File 

To create a parameter file, you use the /r parameter to run the setup executable in record 

mode. This generates a response file (.iss) that contains the settings you chose while 

recording. These become the default settings 

 
Reference: Oracle User Productivity Kit, Installation And Administration Release 11.0, Unattended
Installation
 
 

 

 

QUESTION NO: 4 
 
While you are working offline, the training administrator changes the permissions to the folder in
which you have created a new topic. The permissions are changed to "List Only."
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What happens when you go online and your library is synchronized with the server?
 
 
A. The content administrator is warned automatically and will restore your folder permissions so
that your work is safe. 
B. The document will appear in the Lost document view. 
C. The permissions for the folder are automatically restored to modify permissions during the
synchronization. 
D. I can revert the permissions myself after I receive a system warning. 
 

Answer: B

Explanation: Lost documents 

Lost documents (new or edited documents) can result if permissions change when an author is 

working offline. For example, if an author had Modify permissions to a folder and then went 

offline while the administrator changed your permissions to List Folder Contents. Any new or 

edited document will be identified as a lost document when the author reconnects and begins 

working online. If this happens, an author can display the Lost documents view and recover 

the documents by moving them to a folder with valid permissions. The status bar of the 

Developer displays a message when lost documents are detected. 

 
Reference: OracleUser Productivity Kit, Installation And Administration Release 11.0,Lost
documents
 
 
 

 

 

QUESTION NO: 5 
 
Identify three compatible file formats that can be used when updating or customizing your logo in
UPK.
 
 
A. JPG 
B. PPT 
C. TIF 
D. BMP 
E. EXE 
F. PDF 
G. HTML 
 

Answer: A,C,D

Explanation: To customize logos globally for all publishing styles in a category, you can use the

Customize Logo command on the Tools menu. This command prompts you to choose a category

of publishing styles and an image file. You can choose to replace the default logo with any image

in .gif, .bmp, .jpg, .jpeg, .tif, or .png file format. The Developer converts and renames it to

small_logo.gif, and replaces all instances of small_logo and large_logo in all output styles for the
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selected category. This process will override any existing graphics that are in the existing

publishing styles. 

 
Reference:UPK Master Documentation Library,Use the Customize Logo Tool
 
 

 

 

QUESTION NO: 6 
 
During the installation of 110 PRO, you receive an error message. What is the first task you do
when entering “My Oracle Support”?  
 
 
A. Log a Sev 1 Service request. 
B. Look in the Knowledge base for known issues. 
C. Look in patches and updates to see if there is a patch to download to resolve the issue. 
D. Create a forum post asking other clients and support representatives for clues or steps to be
taken to resolve the issue. 
 

Answer: B

Explanation: Search the Knowledge Base for the error. 

 

 

 

 

QUESTION NO: 7 
 
UPK Developer requires Microsoft .NET Framework 3.5. Some of the machines in the organization
where Developer will be installed already have .NET Framework 3.5 installed, but most do not.
Organizational policy dictates that ALL of the machines where Developer will be installed DO NOT
have access to the internet for security reasons. The UPK installer comes packaged with a
"bootstrap" installer for .NET Framework 3.5, which connects to the Internet to install .NET
Framework 3.5 from there.
 
 
Identify the method that would ensure that UPK Developer is installed securely with its .NET
Framework 3.5 requirement.
 
 
A. Temporarily allow all machines access to the Internet during the duration of the distribution of
the installation, so that the "bootstrap" installer can connect properly. 
B. Embed the full .NET Framework 3.5 installer package within the UPK installer, allowing the
UPK installer to use that package Instead of "bootstrap." 
C. Ensure force installation of .NET Framework 3.5 on ALL machines before the installation of
UPK Developer. 
D. Install only to the machines with .NET Framework 3.5 already installed; delay installation on
other machines until they have been updated with .NET Framework 3.5. 
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Answer: B

Explanation: No need to use the internet to install the.NET Framework 3.5. 

 

 

 

 

QUESTION NO: 8 
 
A content administrator has asked you to troubleshoot a multi-user UPK Installation: the authors
unable to connect to the server. The administrator sent you the following message from a
Windows event log: 
 
 
The current identity (NT AUTHORITY\NETWORK SERVICE) does not have write access to
"C:\WINDOWS\Microsoft.NET \Framework\v2.0.50727\Temporary ASP.NET Files'.
 
 
Where can you fix this permission problem?
 
 
A. On the Oracle database server 
B. On the affected client workstations 
C. In the UPK library 
D. On the application server 
 

Answer: D

Explanation: The .NET FRAMEWORK is used by the application server. 

 

Note: Example: 

When you have created virtual directory of your application created in .Net2.0 and application is

not running.Even everything is fine in web.config, still it is giving error in web.config file.Error :- The

current identity (NT AUTHORITY\NETWORK SERVICE) does not have write access to

'C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\Temporary ASP.NET Files'. Solution is goto

command prompt then navigate to

directoryC:\WINDOWS\Microsoft.NET\Framework\v2.0.50727Now run this commandaspnet_regiis

-ga "NT AUTHORITY\NETWORK SERVICE"Everything will work fine. 

 

 

 

QUESTION NO: 9 
 
Your client has deployed the UPK Developer on a Citrix server, so content authors can access it
remotely in Citrix seamless windows. The target application was also installed on the same server.
The authors are unable to record content.
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Choose three actions that you would take to help discover the problem.
 
 
A. Ensure that the "Time to hide recorder window before screen capture" setting in the Options
dialog box is Increased to at least three seconds. 
B. Ensure that the target application (the web browser for web applications) runs in the same Citrix
session as the Developer. 
C. Ensure that keyboard shortcuts are not recorded automatically. 
D. Ensure that the screen shot capture key is changed from the default. 
E. Ensure that the sound is correctly set up in Citrix. 
 

Answer: B,D,E

Explanation: Remote and Virtual Environments 

The Developer can operate in remote and virtual environments such as Citrix and VMware. The 

following are known issues when operating the Developer in these environments:  

 

Citrix:  

*(B)When recording a target application running in a Citrix session, then Developer must 

be running in the same Citrix session. 

 

*(E)Sound output will likely be choppy. 

* (D)Citrix does not pass the [PrintScreen] key to applications running in seamless windows. 

The Developer uses the [PrintScreen] key as the default key for recording topics. 

Therefore, the Recorder will not properly recognize the [PrintScreen] key in a Citrix 

seamless window. The recording key can be changed in the Options dialog box in the 

Developer. 

 
Reference: OracleUser Productivity Kit, Installation And Administration Release 11.0,Remote and
Virtual Environments
 
 
 

 

 

QUESTION NO: 10 
 
You maintain a single UPK Developer Library that includes content for the entire organization. You
have created an outline that includes all of the content for the current project. However, some of
the content is sensitive and should be visible only to the Human Resources group.
 
 
Which process enables you to maintain this library of content and deliver it to the organization
without exposing the sensitive content to the entire organization?
 
 
A. Duplicate the outline and remove the Human Resources topics from the duplicate. Deliver the
full outline to the Human Resources group and the duplicate outline to the entire organization. 
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B. Create a new outline and link all of the existing modules with the exception of the Human
Resources module. Deliver the full outline to the Human Resources group and the smaller outline
to the entire organization. 
C. Create a Role named "Sensitive." Add this Role to all of the Human Resources content. Publish
the outline and use Roles to filter the content appropriately based on the user's role. 
D. Create a State named Human Resources" Add this State to the Human Resources content.
Use "Publish by State" to publish one outline with and one outline without the Human Resources
State. 
 

Answer: A

Explanation:  

 

 

 

QUESTION NO: 11 
 
A content author requests your help.
 
 
The UPK Developer does not correctly recognize objects and action areas while recording a target
application.  The author provides you with a sample topic to review. You notice that the target
application appears in a VMware Player virtual machine window in the screenshots.  The action
areas cover the entire virtual machine window, and the objects in the target application cannot be
recognized.
 
 
How can you fix this problem?
 
 
A. The author should disable automatic recording, because it degrades object recognition when
used with a virtualization software. 
B. The author should maximize the VMware Player window during recording so that the UPK
Developer can recognize the objects in the application. 
C. The UPK Developer should be installed in the virtual machine, and the target application should
be recorded inside the virtual machine. 
D. Exact Match is disabled by default for VMware Player in "Target Application Configuration" in
the Options dialog box. This setting must be enabled. 
 

Answer: C

Explanation:  

 

 

 

QUESTION NO: 12 
 
You can deploy your UPK content by placing the Player package on a web server and making it
available to your users. You do this by copying the contents of the Player Package folder in the
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published content. Then you will need to create a link to two files.
 
 
Identify the two files.
 
 
A. play.exe 
B. index.html 
C. default.htm 
D. tocx.html 
E. kp.html 
 

Answer: A,B

Explanation: Linking to the index.html is how to launch the UPK Player(play.exe)when it's on a

web server (including SharePoint or similar). 

 

Note:What is the underlying architecture of the UPK Player? 

A: The UPK Player is DHTML (Dynamic HTML, which is HTML and JavaScript). The images are

PNG format. 

 

 

 

QUESTION NO: 13 
 
You are engaged as a UPK administrator and publisher for a customer who is in the process of
upgrading their Oracle EBS application suite to R12.x. The UPK content development team has
finished the first set of topics and asked you to publish the content, so their SMEs can directly
access the topic they are responsible for. The SMEs are busy and do not have time to download
Individual topics.
 
 
Which method should you choose to publish and distribute the content?
 
 
A. Publish the content to the individual topic outputs and host the topics on a web server providing
links to each topic. 
B. Publish the content using the Player/LMS output and distribute the player package folder to
each SME. 
C. Publish the content using the Player/LMS output and host the content on a web server and
provide the SMEs with a link to the play.exe file. 
D. Publish the content using the Player/LMS output and host the content on a web server and
provide content developers a link tokp.html. 
 

Answer: B

Explanation: Deploy an LMS Package 

The LMS package enables the creation of a package that conforms to the AICC and SCORM 

learning specifications. 

Oracle 1z0-583 Exam

9
https://certkill.com

http://certkill.com
http://certkill.com


 
Reference: OracleUser Productivity, Content Development,Deploy an LMS Package
 
 
 

 

 

QUESTION NO: 14 
 
You have defined a number of customizations for the Knowledge Center user interface. However,
when you test them, the customizations are not displayed. You have verified that the modified files
have all been placed in the proper directories.
 
 
What might be the reason your customizations are not appearing?
 
 
A. The local browser cache on the client system accessing the Knowledge Center must be cleared
for the customizations to appear. 
B. You may be using an unsupported browser. Test your customizations in Internet Explorer
version 8 or 9. 
C. You may not have restarted the Web services on the Knowledge Center server. This will reload
the.lng and .cus files on the web server. 
D. It you logged in to the Knowledge Center before you performed your customization, you will
need to log in as a new user to see the customizations. 
 

Answer: C

Explanation: Restart the web services. This step is required because when the Knowledge

Center 

software loads on the web server all contents of lng and cus files are cached in 

memory. To update this information the services must be restarted. 

 
Reference: Knowledge Center: User And Content Management Release 11.0,Create a
Customization File
 
 
 

 

 

QUESTION NO: 15 
 
You are asked to attend a presales call to support your field account representative with a sale of
UPK. The account representative has asked you to participate in the meeting because the client
has questions about deploying In-Application Support using the SmartHelp browser add-in option
in UPK. 
 
 
The client wants to know what is required to deploy SmartHelp to their user community.
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